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Diagram of the Louisiana coast above shows 
the development of historic lobes of the 

Mississippi River                                                    
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WHAT IS CWPPRA? 

The Coastal Wetlands Planning, Protection and Restoration Act, (CWPPRA, 
pronounced kwǐp-rŭh), is federal legislation enacted in 1990 that is designed 
to identify, prepare, and fund construction of coastal wetlands restoration 
projects. Since its inception, approximately 150 coastal restoration or 
protection projects have been authorized, benefiting over 112,000 acres in 
Louisiana. The legislation (Public Law 101-646, Title III CWPPRA) was 
approved by the U.S. Congress and signed into law by former President 
George H. W. Bush. Learn more at LACoast.gov.  

Why Protect Louisiana? 

Louisiana wetlands are unique and vital ecological assets worth saving. Wetlands act as a storm buffer against hurricanes and storms. They act as flood 
control devices: holding excess floodwaters during high rainfall (much like a sponge). Wetlands replenish aquifers, and they purify water by filtering out 
pollutants and absorbing nutrients. CWPPRA funds have been instrumental in helping to restore Louisiana’s vanishing wetlands. Approximately 40 
percent of the coastal wetlands of the lower forty-eight states are located in Louisiana. Unfortunately, this fragile environment is disappearing at an 
alarming rate. Louisiana has lost up to 40 square miles of marsh per year for several decades – that’s 80 percent of the nation’s annual coastal wetland 
loss. 

                                                                                             History: HOW MARSH WAS CREATED IN LOUISIANA 

Over millennia, sand, silt, and clay delivered via the muddy floodwaters of the migrating 
Mississippi River built the wetlands of Louisiana’s coastal zone.  

Problem: HOW MARSH WAS DISTURBED AND DESTROYED 

With construction of the levees along the river to reduce flood risk to adjacent communities, 
the floodwaters responsible for creating the wetlands were channeled into the Gulf of 
Mexico. Without the annual re-nourishment of sediment and nutrients from the river, 
wetlands have been sinking and converting to open water. Additionally, man-made canals 
changed the hydrology of the area. Natural disasters, such as hurricanes, and manmade 
activity have also caused damage.    

http://www.lacoast.gov/
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USGS Land Area Change in Coastal Louisiana from 1932 to 2010 

 

 

 

                                                              
      

 

Bald Eagle 

 

Trawl Boat 

 

To date, Louisiana has already lost coastal land area equal to the size of 
the state of Delaware. This loss is at an average rate of approximately 
one acre every hour (pubs.usgs.gov/sim/3164/). If the current rate of 
loss is not slowed by the year 2040, an additional 800,000 acres of 
wetlands will disappear, and the Louisiana shoreline will advance inland 
as much as 33 miles in some areas.  

Wetlands also provide habitat for a variety of 
wildlife. Coastal Louisiana lands are the breeding 
grounds and nurseries for thousands of species of 
aquatic life, land animals, and birds of all kinds – 
including our national symbol, the bald eagle. This 
ecosystem also provides a migratory habitat for over 
five million waterfowl each year. 

 

People also benefit from Louisiana’s coastal lands. Louisiana is 
responsible for a major part of our nation’s oil and gas production, 
shipping commerce, fisheries industry, fur harvesting, and oyster 
production. These industries account for over 55,000 jobs and billions 
of dollars in revenues.  

Additionally, wetlands are 
wonderful recreational resources 
and are part of Louisiana’s 
growing ecotourism business. To 
learn more about the economic 
value of our wetlands, read “The 
Cost of Doing Nothing” in 
WaterMarks (Summer 1999). 

CWPPRA project managers, scientists, and engineers use a variety of 
techniques to protect, enhance, or restore wetlands. Each restoration 
project may use one or more techniques to repair delicate wetlands. 
These techniques include but are not limited to: shoreline protection, 
barrier island restoration, marsh creation, fresh water reintroductions, 
sediment diversions, hydrologic restoration, marsh management, 
sediment and nutrient trapping, terracing, outfall management and 
vegetative plantings. 

The CWPPRA Task Force implemented the Coastwide Reference 
Monitoring System (CRMS) as a mechanism to monitor and evaluate 
the effectiveness of CWPPRA ventures at the project, region or 
hydrologic basin, and coastwide level. The CRMS design implements a 
multiple reference approach by using aspects of hydrogeomorphic 
functional assessments and probabilistic sampling. This training manual 
is designed to help you learn more about the CRMS (pronounced 
crimms) by using the web at LACoast.gov/CRMS.  

http://pubs.usgs.gov/sim/3164/
http://lacoast.gov/new/Pubs/WaterMarks.aspx?yr=1999
http://lacoast.gov/crms2/Home.aspx
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Scientist working a CRMS site 

 

Scientist gathers data at a CRMS site 

 

CRMS site in a marsh area of Louisiana 

 

WHAT IS CRMS? 

CRMS is the acronym for the Coastwide Reference Monitoring 
System.  The Coastal Wetland Planning, Protection and Restoration Act 
(CWPPRA) has, from its beginning, monitored the health of 

Louisiana’s landscape. 
Initially, information was 
collected through aerial 
photography, on-the-
ground assessments and 
comparisons of project to 
reference sites. But to 
improve methods of 
rebuilding Louisiana’s 
resistance to erosion, 

reducing conversion of her 
marshes to open water, and 

saving her from the fatal complications of starvation and sinking, more 
comprehensive data were soon needed. In 2003, CWPPRA established 
the Coastwide Reference Monitoring System (CRMS).  

                    
Today, about 390 
CRMS sites, 
spread throughout 
coastal Louisiana, 
broaden the 
reach, increase the 
frequency and 
expand the detail 
of wetland data. 

  

The CRMS project, under the 
direction and funding of 
CWPPRA, is one of the largest 
coastal habitat monitoring 
networks in the United States.  
The CRMS team effectively 
delivers data to a variety of 
audiences with roughly 60 scientists 
employed to go out into the field to 
collect data from CRMS sites and additional analytical teams of 
scientists, computer programmers, and software engineers designing 
Web delivery of large data sets.  

Monitoring data include: 

• water level, 
• salinity, 
• sediment accretion,  
• surface elevation change, 
• composition and abundance of vegetation, 
• ratio of land to water, and 
• soil characteristics. 

The information is analyzed and summarized in maps, charts, tables, 
graphs, and indices, and finally incorporated into interactive report 
cards available online. 

From identifying areas in need of restoration through evaluating a 
project’s long-term effects on the landscape, the CRMS program 
contributes to the successful planning, modeling, and study of coastal 
restoration.  
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List of Parameters: 

Parameter Method Scale Frequency Type of 
Data 

Land to Water Ratio Satellite Imagery Hydrologic Basin At least once per year Spatial 

Land to Water Ratio Digital Aerial Photography CRMS Site (1 km2) 
 

Once every 3 to 5 years 
 

Spatial 

 Surface Water Salinity, 
Temperature, and Water Levels Submersible Data Logger 

In available water within 200 
meters of CRMS site or in a 

well 
Hourly Non-Spatial 

Soil Porewater  10 and 30 cm syringe sippers 3 samples per depth per site 
and at vegetation plots Intermittently and Annually Non-Spatial 

Herbaceous Vegetation  % Cover, Species Richness, 
Height of Dominant Species 

(10) 2 m by 2 m plots per 
marsh site or (9) plots per 

swamp site  
Annually during peak biomass Non-Spatial 

Forested Vegetation 
DBH (diameter at breast 
height), Canopy Cover, 
Understory Vegetation 

(3) 20 m by 20 m forested plots 
per swamp site and 

 (9)  6 m by 6 m understory  
plots per swamp site 

Once every 3 years during peak 
biomass Non-Spatial 

Soil Characteristics 

Core samples profiled into  
4 cm increments to 24 cm. Bulk 
Density, % Organic Matter, Soil 

Salinity, pH, and Moisture 

3 cores, 18 archived samples 
per site Once every 6 to 10 years Non-Spatial 

Marsh Elevation Changes Rod Surface Elevation Tables 
(a.k.a. RSET) 4 directions per site Bi-annually Non-Spatial 

Vertical Accretion Feldspar Plots/Cryogenic Cores Multiple plots per site Bi-annually Non-Spatial 

 

See Appendix 1: For Details on CRMS DATA COLLECTION INFORMATION AND SCHEDULE 
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CRMS Site vs. CRMS Station 

Typical CRMS Marsh Site 

CRMS Sites 

CRMS sites are very large. Land to water classification of a CRMS site is 
the spatial or three dimensional data that are collection within a 1km2 
area. That is approximately the size of 187 football fields.  

However, the majority of on-the-ground data collection is conducted 
within a smaller non-spatial data collection area.  Non-spatial data 
include: information about water, vegetation, soil, marsh elevation, and 
vertical accretion.  

 

The non-spatial 
data collection area 
is 200m2 or about 
the size of 7 
football fields.   

 

 

CRMS Stations or Data Plots 

Within the data collection area, many data stations (or plots) exist. Each 
CRMS site has a hydrologic station, vegetation stations, accretion 
stations, etc.  In the diagram you can see how the stations are laid out 
within a CRMS site.  The 10 vegetation stations are in a diagonal 
transect across the 200m2 data collection area. The rod surface 
elevation and accretion stations are nested around a boardwalk. The 
hydrologic station is generally in a bayou or water body near the 
boardwalk.  

Naming Convention 

CRMS sites and stations have a standardized naming convention. 
CRMS sites are indicated by 4 numeric digits following the letters 
CRMS (ex, CRMS0001).  CRMS station names have the CRMS site 
name followed by a hyphen and the station number. For example 
CRMS0001-V01 would indicate vegetation station 01 at CRMS site 
0001. Each data type has a distinct letter in the station naming 
convention. Appendix 1 should help you translate the station names. 

See Appendix 1: For Details on CRMS DATA COLLECTION 
INFORMATION AND SCHEDULE
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NAVIGATE THE WEBSITE 

CRMS is easily accessed on the web at LaCoast.gov/CRMS. The 
website is currently in its second generation of web design.  When you 
first arrive at the page, you will see a “home” page similar to the one 
below. 

 

Notice:  In general, it is better to use a web browser such as Mozilla 
Firefox or Google Chrome.  Some features of the CRMS website 
cannot be properly viewed in older versions of Internet Explorer.  

Clicking on the mapping menu item at the top of the webpage will load 
an interactive map of the Louisiana coast.  By hovering over the word 
“Mapping,” a drop box will appear. Choose Basic Viewer by clicking 

one time or alternatively, click on the map icon. The page below will 
appear. Each of the yellow dots indicates an actual CRMS monitoring 
site.  Parameters are measured and recorded at each of these sites.   

 

Additionally, on 
the left hand side 
of the page you 
will see a “Layers 
Menu” that can be 
used to view 
different layers. 
Clicking on 
checked boxes on 
the left side of the 
layers menu will 
load data onto the 
map.  This data is 
relevant to the 
layer item.  

 

IMPORTANT: Click in the check box on the left and the layer 
will be visually displayed. Click on the red check on the right side 
and the data becomes active. Clicking on a map item in an active 
layer will provide information about the layer item.  Example: 
Activate the CRMS layer and when you click on a yellow dot, a 
site information box appears  

NOTE:  You can only have one RED CHECK active at a time! 
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Try this step by step example:  

1.  In the Layers Menu, click on the box next to the yellow CRMS dot. The check will disappear and 
the CRMS data will be removed from the map.   
2.  Now click on CWPPRA and Hydro Basins.  Both the CWPPRA projects and the Hydrologic 
Basins will be displayed on the map. 
3.  Try clicking on each of the “layers” to see how the map changes. Note that some of the layers are 
not transparent and so it can be difficult to see several layers at one time. However, if you expand the 
layers categories you will see "fill" controls like Vegetation and Land/Water that allow you to adjust 
layer transparency (by clicking on the arrows to the left of the layer category name). 
  

  Using CRMS for Site Specific Data 

As mentioned earlier, each yellow dot represents a CRMS data collection site. If you would like to find out information about a 
particular CRMS site, single click on the bar just after the letters CRMS (or the CRMS text in the layer menu data). A drop down 

menu will appear, similar to the one at the right of this page. The small black down 
arrow just after CRMS0002 will show a drop down menu with all of the active CRMS 
sites.  Scroll through and pick the CRMS site of your choice. This technique will work 
to show a drop down menu for each of the layers.  For the purposes of 
demonstration in this manual, look at CRMS site CRMS0523 and CWPPRA project 
BA-20 to investigate how the CRMS information is organized. CWPPRA project 
names that correspond to the numbers can be found at 
LACoast.gov/new/Projects/List.aspx 

Note: The layers menu was setup to only have one menu open at a time. In other words, only one layer 
category can be expanded at one time. This keeps the menu from getting too large and going beyond the 
height of the screen. 

Example: Selecting a CRMS site. CRMS Site0523  Use the “Zoom To” drop down list to select CRMS0523. Click once on CRMS0523 to select the 
site from the drop down list. The site number will be highlighted in blue in the drop down list. When selected, the map will zoom to the site CRMS0523 
and an information box will appear.  

http://lacoast.gov/new/Projects/List.aspx
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Each of the tabs at the top of the site information box will provide 
facts for the user.  Included in the tabbed markers are: Information, 
Water, Vegetation, Soil, Spatial, Report Card and Tools.  

INFO TAB 

The Information tab includes the site ID number, the latitude and 
longitude, marsh elevation, a data availability graph, monitoring site 
pictures, and a PDF report that includes details about elevation surveys 
of the site.   

 

If a site is located within a CWPPRA project (ex., CRMS0672) the 
CWPPRA project name and project type will also be included on the 
information tab. 
  
The data availability graph includes information about what data were 
collected at this particular site each year.  There is a standard data 
collection protocol with established sampling periods but in special 
cases a site might not have data (ex., a hurricane destroyed accretion 
plots). Simply click on the arrows to see the data that were gathered 
each year. By clicking on the data availability graph once, the graph will 
be displayed larger, showing details such as which months the data were 
collected.

WATER TAB 

The Water tab has information about salinity, water level, temperature, 
the hydrologic index, and water level range. Each underlined 
subheader will provide additional graphs and data.  Salinity, water level, 
and water temperature graphs can be selected for the most recent 30 or 
90 days of available data.  These intervals allow for a better 
understanding of what is happening at each site.  If you would like a 
different period of record for the data type you can choose date ranges 
in the Visualizations/Charting section of the website. 

 

 

 

 

 

 

 

 

 

The Interactive Hydrology Chart at the bottom of the Water 
tab/Salinity subheader can chart several factors at one time.   
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Click on each of the underlined words (subheaders) to investigate the 
water data for CRMS0523. 

Scientists and educators use these data to answer important questions 
about the health of wetlands. Questions such as:  

• What might be a cause of the daily changes in salinity?  Or, what 
influences salinity? 

• Which day during this month had the highest salinity? 
• What might be a cause for the spike in salinity? 
• What day had the lowest salinity? 
• Identify organisms that are affected by salinity.  
• Estimate the number of days during the month that the marsh is 

inundated or covered with water? 
• Estimate the high tide on a particular day?  
• Estimate the low tide on a particular day? 
• How deep is the water over the marsh surface when the marsh is 

flooded at a particular CRMS site?  

The final two subheadings (Hydrologic Index and Water Level Range) 
help assess site specific hydrologic conditions. The Hydrologic Index 
(HI) jointly assesses the suitability of two critical aspects of wetland 
hydrology, average salinity and percent time flooded, in maximizing 
vegetation primary productivity for the 5 different marsh classifications 
in coastal Louisiana including swamp, fresh, intermediate, brackish, and 
saline. The Water Level Range graph compares site specific marsh 
elevation with mean water level and water level observations.  

In the lower left corner of this water level graph there is a link to 
download data. This "Download Data" link appears on graphs 
throughout the website. By clicking the link the data will be 
downloaded to your computer as a Microsoft Excel file. Once 
downloaded, opening the files will display actual numeric values of the 
data on the graph. 
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VEGETATION TAB 

The Vegetation tab includes three basic subheaders: herbaceous, FQI, 
and marsh classification.  The Herbaceous subheader provides 
information about the observed vegetation at CRMS sites. The 
vegetation surveys are done in 4 meter2 (usually 10 stations [i.e. plots] 
per CRMS site) along a diagonal transect that crosses the 200 meter2 
data collection area for each CRMS site.  

Again, by single clicking on the graph; the graph will enlarge and the 
names of the plants and the associated percent coverage are displayed 
on the bar graphs. Clicking on the graph one more time will make the 
graph small and return you to the original vegetation tab. 

 

 

 

 

 

 

 

 

 

 

 

The FQI subheader contains information about the Floristic Quality 
Index. The Floristic Quality Index (FQI) was developed for coastal 
Louisiana, similarly to other regions of the U.S., to determine the 
quality of a wetland based on its species composition. The FQI is 
scored from 0 - 100 which can be calculated at the CRMS station, site, 
or project scale. To learn more about FQI, click on the “What does this 
chart mean?” information link under the graph. 

 

 

The FQI graph displays both the percent cover and the FQI score for 
each vegetation survey. Each species is identified by name and a legend 
is provided to indicate which species corresponds to each color and 
what the coefficient of conservatism score (CC) is for each species 
observed. 
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The last subheading under Vegetation is Marsh Classification. Marsh 
classification is important because it helps the scientific community 
determine whether physical conditions at a site are changing and 
causing shifts in the vegetation.  For example, is a site becoming more 
saline due to salt water intrusion or is a site freshening due to a 
freshwater introduction project. 

 

There are two ways that the vegetation data are collected: by helicopter 
survey and on-the-ground CRMS vegetation surveys. 

Vegetation types of fresh, intermediate, brackish, saline, and swamp are 
assigned to CRMS sites by an algorithm that uses species composition 
and cover data collected annually from the sites.  Every CRMS site is 
assigned a marsh classification each year using the available vegetation 
data at the site. 

The graph below for CRMS0523 shows that marsh stations (i.e., plots) 
within a CRMS site can vary in classification. Again, actual data can be 
downloaded as a Microsoft Excel spreadsheet by clicking on the 
Download Data link at the lower left of the graph.  

 

 

 

 

 

 

 

 

A careful look at the graph indicates that the area was primarily 
intermediate in 2007 and changed in 2008 to brackish or saline. 
Questions about what caused that change might include: whether 
drought conditions existed during 2008 or did Hurricane Gustav bring 
in salt water. These types of data extension questions promote higher 
order thinking skills in scientists and students alike.   

 

Again, a legend to the right of the graph identifies the primary habitat 
types as fresh, intermediate, brackish, saline and swamp. Certain species 
(indicator species), when present at designated abundance levels, can be 
used to assign marsh types to CRMS sites. 
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After viewing the Vegetation tab, questions about plant composition 
in the area might include: 

• What year was the first data recorded about plants at this 
site? 

 
• What year was the last data recorded at this site? 
 
• Which plant is the most common in the most recent year? 
 
• Give the percent coverage of Spartina patens from the 

herbaceous marsh vegetation graph. 
 
• Why is plant diversity important in an ecosystem? 
 
• Which plant(s) make up less than one percent of the plant 

composition?  
 
• What role do you think plants play in habitat restoration?  
 
• As a student, if you were going to help out with coastal 

restoration, which type of activity would you prefer to do 
and why? 

o Grow new plants for restoration. 
o Volunteer to help with a coastal restoration 

planting event. 
o Write an article in the school newspaper to share 

information about restoration. 
o Create a video to share information about coastal 

Louisiana. 

The other important tool on the Vegetation tab, Herbaceous subheader 
is a link to the U.S. Department of Agriculture (USDA) Plant Database. 
This link will direct you to an official list of all the plants identified by 
the USDA.   
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SOIL TAB 

The Soil Tab includes three subheaders: percent organic, bulk density, and surface elevation/accretion/SVI.  The primary function of this section is to 
provide information about the soil at each particular site. Although all CRMS sites are in coastal wetlands, soil characteristics vary greatly across the 
landscape and even within one soil core. 

Open each of the subheaders to view the graphs that include information 
about the sediment cores.  Again, data can be downloaded to a Microsoft Excel 
spreadsheet by clicking on the lower left corner of the enlarged graphs for both 
percent organics and bulk density.  

The Surface Elevation and Accretion data help to determine if a location is 
maintaining a consistent elevation or is it submerging or emerging through 
time. 

 

 

 

 

 

 

 

 

Elevation change is measured with the Rod Surface Elevation Table (RSET) and is calculated cumulatively, relative to readings made during station 
establishment. Vertical Accretion is measured above feldspar marker horizons. Original marker horizons are established concurrently with initial RSET 
measurements. New feldspar marker horizons are regularly established, providing multiple vertical accretion measurements. The lines in this figure are 
linear fits through the elevation change measurements for each direction (n=4 per sample date) and vertical accretion measurements (n=3 per sample 
date, establishment date).
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SPATIAL TAB 

The Spatial tab includes three subheadings: land/water, maps, and 
aerial photography. Click on all three to test the interface. The 
Land/Water subheader gives a visual overview of the percent land at 
the CRMS site. 

 

The arrows directly above the images allow users to view which parts 
of the CRMS site were land and water during previous years when land 
to water analyses were completed. 

In addition to the brown and blue map, a table indicates the number of 
acres of land and water and the percent of land and water at each 
CRMS site.  

The Maps subheader displays a map created using aerial imagery. The 
red box indicates the 200m2 data collection area for the CRMS site. 

 

 

 

 

 

 

 

 

Aerial photography has been used widely in the United States since the 
1930s to assist land managers in the evaluation of natural resources. 
Under the Aerial Photography subheader, digital imagery is used to 
create “false colors.” The red color is associated with live vegetation.  
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SITE LEVEL REPORT CARD 

As evidenced by the review of just one monitoring site, CRMS collects 
monitoring data for numerous ecological parameters. Data have been 
summarized in a “Report Card.” Using CRMS data, unique indices have 
been developed by the CWPPRA program to create an interactive 
report card.  The report card summarizes information and displays 
scores and detailed information for individual CRMS sites, restoration 
projects, hydrologic basins and the entire Louisiana coast. The report 
creates pie charts and graphs for a variety of indices. 

  

A detailed description of what information is in the report card and 
what that information actually represents can be found by clicking on 
the Report Card link at the top of each Report Card tab.  

Report Card file sizes may be large and may take a minute to download. 

Clicking the arrows to the left and right will cycle through report cards 
available for other years. The graphs available on the Report Card tab 
are meant to give a brief overview of how the site is performing 
without having to read the entire report card.  Report cards are created 
for each year that sufficient data are available. You can also access 
report cards at LACoast.gov/chartingwebservices2/report_cards 

Observe that each index helps explain the conditions of a particular 
aspect of the coastal wetlands ecosystem. By comparing indices at 
various times and spatial scales, managers can understand the overall 
condition of coastal wetlands in Louisiana.  

Because no regulatory thresholds currently exist for the ecological 
parameters of interest in the CRMS program, it was not possible to 
assess index scores based on previously defined values that would 
indicate an acceptable or unacceptable score. The report card was 
designed to help resource managers evaluate the ecological conditions 
and trajectories of change for a site, a restoration project, projects, or 
even hydrologic basin. 

There is also a small "i" button on the top left of the report card page. 
If you click that “i,” it will give a description of how the CRMS team 
assessed indices for the report card. The breaks for good, fair, and poor 
are based on the distribution of index scores across all CRMS sites. 

 

Much like a student report card, the values are given in percentile. 

http://www.lacoast.gov/chartingwebservices2/report_cards
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TOOLS TAB 

The Tools tab is the final tab on each CRMS site information box.  It 
includes information on land and water changes over time and coastwide 
vegetation over time.  Simply click on the year to access the information. 

 

Under Land/Water the data is displayed in both acres and percentage with a 
pie graph to accompany the data. The map behind the information box also 
changes to display the land/water map for the year that is chosen. Note: The 
map to the left is for 2008. 

 

Under Coastwide Vegetation, each of the habitat types are identified and 
both the acres of each type and a pie chart of the habitat types are available. 
The map behind the information box also changes to display the coastwide 
marsh classification map for the year that is chosen. Note: The map to the 
left is for 1949 and predates CRMS on-the-ground vegetation surveys. These 
coastwide vegetation types are based on the helicopter survey data.  
Additional information is provided about the helicopter based vegetation 
classifications below.  
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Using CWPPRA Project Information Layer 

From the CRMS home page (LACoast.gov/crms), hover over the word 
“Mapping.” By hovering over the word “Mapping” a drop box will 
appear.  Choose Basic Viewer (Current) by clicking one time. The page 
below with a map of Louisiana’s coastal zone will appear. The map may 
contain different markings such as CRMS sites but by clicking on the 
box to the left, the layers are easily changed.   

Now that we have gone over the data and options available from the 
CRMS layer, let’s go into the CWPPRA layer.  Click on the gray check 
to the right of the CWPPRA layer text inside the layer menu.  This will 
make the CWPPRA layer the active layer and will allow the map to 
display data relevant to it. Click on the white box to the left of 
CWPPRA, a left check will appear and then click on the bar next to the 
acronym CWPPRA.  A drop down menu will appear that includes the 
words Zoom To, Constructed, Not Constructed, Infrastructure, and 
Legend.  Choose the items you would like to have displayed or 
visualized. Note: UNCHECK boxes you do not what displayed or 
visualized.  Each of the grey areas on the map that are 
surrounded by a red line indicates a CWPPRA project boundary.  

BE SURE BOTH THE LEFT  AND RIGHT   BOXES are checked for project 
information box to appear. 

You can click on the down arrow next to the project letter/number 
designation or scroll over the map to choose a project. As an example, 
click the down arrow and choose BA-20 at the bottom of the list.  This 
letter/number combination is part of the coastal restoration project 
naming convention for Louisiana. Instead, you may choose to simply 
click on highlighted area of the map to view a project.  

The project number BA-20 is named Jonathan Davis Wetland 
Protection. The project is in SE Louisiana. When BA-20 is clicked, the 
map will automatically enlarge and shift to take to a close up view of 
the project area and an information box will appear. 

  
 

INFO TAB 
The Info tab contains information including: the State ID Number, the project 
Name, acronyms for the federal and state Sponsors, the Type of restoration 
technique that is primarily being used, a Link to the general project fact sheet and the 
Objectives and Goals of the project.    
 
Click on the link to see the General Project Fact Sheet for BA-20 the Jonathan Davis 
Wetland Protection project. Note: The LACoast.gov website contains a host of 
information on each project under the Project tab at 
LACoast.gov/new/Projects/List.aspx.   

http://www.lacoast.gov/CRMS
http://lacoast.gov/new/Projects/List.aspx
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WATER TAB 
 

 

 
The Water tab has information about salinity, water level, 
temperature, and water level range. Each underlined subheading will 
provide additional graphs and data.  Salinity, water level, and water 
temperature graphs for stations within the project can be selected for 
the most recent 30 or 90 days of available data.  These intervals allow 
for a better understanding of what is happening at each CWPPRA 
project location. 
 

 
 
 
If there is a CRMS site within the project boundary, the station 
number(s) will appear and the data that was collected will be displayed 
along with project specific data described.  
 
 
 
 
 
 
 

Click on each of the subheadings to explore the data related to the 
water parameters. 
 

 

 

 

 

 

Single click on the graph and the image will increase in size and a 
“Download Data” link will appear in the lower left corner.  
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VEGETATION TAB 

The Vegetation tab includes three subheaders: marsh classification, 
project/ref FQI, and side-by-side. 

 
The Marsh Classification 
subheading pulls up two different 
graphs, one for the project and 
one for the reference sites. These 
graphs contain information about 
marsh type based on plant 
composition and are classified 
into fresh, intermediate, brackish, 
saline, and swamp for project or 
reference stations.   

 
 
The Project/Ref FQI subheading also pulls up a graph of percent 
cover by species composition, reference stations and FQI scores. The 
term FQI stands for the Floristic Quality Index. The Floristic Quality 
Index (FQI) was developed for coastal Louisiana, similarly to other 
regions of the U.S., to determine the quality of a wetland based on its 
species composition. The FQI is scored from 0 - 100 which can be 
calculated at the CRMS site and project scale.  On the right side of the 
graph there is a legend that includes a list of the dominate species that 
were identified during a field survey. 
 

Single click on the graph and the image will increase in size and a 
“Download Data” link will appear in the lower left corner.  

 
The Side-by-Side subheading allows users to compare a project’s 
marsh classification across multiple years. 
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The PROJECT LEVEL Report Card 

As evidenced by the review of just one CWPPRA project BA-20, 
monitoring data for numerous ecological parameters are available. Data 
have been summarized in a “Report Card.” Using CRMS data, unique 
indices have been developed by the CWPPRA program to create an 
interactive report card.  The report card summarizes information and 
displays scores and detailed information for individual CRMS sites, 
restoration projects, hydrologic basins and the entire Louisiana coast. 
The report creates pie charts and graphs for a variety of indices. 

  

 

 

 

 

 

 

 

 

 

A detailed description of what information is in the report card and 
what that information actually represents can be found by clicking on 
the Report Card link at the top of each Report Card tab. Clicking the 
arrows to the left and right will cycle through report cards available for 
other years.  The graphs available on the Report Card tab are meant to 

give a brief overview of how the site is performing without having to 
read the entire report card. Report cards are created for the project 
level as sufficient data are available. 

Observe that each index helps explain the conditions of a particular 
aspect of the coastal wetlands ecosystem. By comparing indices at 
various times and spatial scales, managers can understand the overall 
condition of coastal wetlands in Louisiana.  

Because no regulatory thresholds currently exist for the ecological 
parameters of interest in the CRMS program, it was not possible to 
assess index scores based on previously defined values that would 
indicate an acceptable or unacceptable score. The report card was 
designed to help resource managers evaluate the ecological conditions 
and trajectories of condition changes of a site, a restoration project (s), 
or even hydrologic basin. 

 

There is also a small "i" button on the top left of the report card page. 
If you click that “i,” it will give a description of how the CRMS team 
assessed indices for the report card. The breaks for good, fair, and poor 
are based on the distribution of index scores across all CRMS sites. 
Much like a student report card, the values are given in percentile.



 
   
 

Page | 21 
 

TOOLS 

The Tools tab is the final tab on each CWPPRA project.  It includes 
information on land and water changes as well as vegetation over a period of 
time.  Simply click on the year to access the information. 

 

Under Land/Water the data is shared in both acres and percentage with a pie 
graph to accompany the data. The map behind the information box also changes 
to display the land/water map for the year that is chosen. Note: The map to the 
left is for 1978. 

 

 

 

 

Under Coastwide Vegetation, each of the habitat types is identified and both 
the acres of each type and a pie chart of the habitat types is available. The map 
behind the information box also changes to display the Coastwide Vegetation 
for the year that is chosen. Note: The map to the left is for 1978. 
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Additional CWPPRA Project Monitoring  

Additional information is available on LACoast.gov.  

 

To learn more about CWPPRA projects and project specific 
monitoring, visit the web at LACoast.gov. Click the Projects button or 
find a location on the map.  For example, type in “BA-20” in the Get 
Project Details line and a list of fact sheets, reports and maps will 
become available. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click on the title of the report and a “.pdf” file will open with the 
information. 

 

 

 

 

 

 

 

http://www.lacoast.gov/
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ADDITIONAL CRMS MAPPING TOOLS 

Located near the top left of the page are six additional tools. From left to right:  

1. The icon with four arrows removes the CRMS heading and allows the map to take up more of the browser window. The tool can change the 
map size simply by clicking once on the icon. 

2. The second icon, which looks like sheets of paper, is the Layers Menu which will visually add or remove the layers menu by clicking once on 
the icon. REMEMBER The layer will be visually displayed but to access the data you must click on the red check on the right side 
of the Layer Menu to activate the data layer or for the data to become active.  NOTE:  You can only have one RED CHECK active 
at a time! 

3. The third icon, which looks like a pencil and a ruler, will load the Tools. By single clicking on the icon the Tools Menu will appear. Two layers 
appear under the Tools tab: Classify and Assessment. More on that later! 

4. The fourth icon that looks like a magnifying glass is a Zoom Tool. Click once on the Zoom Tool and the scroll wheel on a mouse (or third 
mouse button) will help you zoom in or out on the map. 

5. The fifth icon, which looks like a globe, is the “zoom to full extent” tool. This tool will bring the map zoom level and position back to the 
default setting. In other words, the viewer can see the entire coast of Louisiana and the edges of the Texas, Mississippi and Alabama coasts. 

6. The plus and minus symbols zoom in and out on the map one zoom level at time.  
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ADDITIONAL LAYERS MENU  
 
The additional layers on the CRMS site can be used to view different 
types of data. Clicking any of the check boxes to the left of the layer 
item will display the data relevant to that layer.  

 
 
 
Hydro Basins 
 
Hydrologic basins in Louisiana include the area of land where surface 
water from rain and tributaries drain into the Gulf of Mexico.  
 
 
Clicking the gray check to the right of the Hydro Basin layer text will 
make that the current active layer. This will display the hydrologic 
basins for the Louisiana coast in blue with a gray transparency. Clicking 
on the map inside any of the blue areas will load an information 
window with information about the chosen hydrologic basin. The map 

above shows both the CRMS sites in yellow and the CWPPRA 
hydrologic basins outlined in blue.  
 
 
 
The basins from west to east and north to south are:  

• Calcasieu/Sabine (CS), 
• Mermentau (ME),  
• Teche/Vermilion (TV),  
• Atchafalaya (AT),  
• Terrebonne (TE),  
• Barataria (BA),  
• Pontchartrain and Pearl River (PO),  
• Breton Sound (BS), 
• and the Mississippi River (MR). 

 
 
The map below, created by the USGS National Wetlands Research 
Center in 1994, identifies the major hydrologic basins along the 
Louisiana gulf coast.  
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In the example below, the Pontchartrain Basin is highlighted.  The 
information window includes three tabs containing general information 
(Info), a Report Card, and Tools similar to the tabs discussed in 
previous sections.  
 

 
 
To leave this information window simply click on the X in the upper 
right corner. 
 
Vegetation 
 
The next item on the Layers Menu is Vegetation.  This layer contains 
information about the various plants that occur in the wetlands. These 
data come from point information that is gathered from coastal 
helicopter surveys or flyovers. The point data were interpolated into 
polygons delineating vegetation types coastwide such as fresh, 
intermediate, brackish, saline, and swamp.  There are several pieces of 
information that can be accessed here. 

Again, click the right and left boxes next to 
the word “Vegetation.”  The vegetation layer 
will be visualized on the map and the data 
associated with this map will be accessible.  
Choose a year in the “Main Layer” to identify 
which year you want to see.   
 
You will also notice that there is a “Main 
Layer” and a “Diff Layer.” These two layers 
allow the user to compare vegetation over 
time. To use the vegetative difference layer, 
(“Diff Layer”) start by selecting a vegetative 
difference year and turning on the vegetative 
polygon by clicking on the box marked 
“Polygons.”  Solid colors indicate areas where 
there has been no change between the 
selected years and striped colors indicate 
changes in vegetation between years.  
   

 
You can use the increase 
resolution (+/_) or wheel 
on the mouse to get a 
closer look at the map.  
Also, be sure to turn the 
legend on in order to 
know what the colors 
represent in both of the 
years. Hovering the mouse 
over the map will create a 
call out box that identifies 
the areas of change. 
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A coastwide map showing vegetation change would look 
similar to the one on the left.  
 
 
 
An interesting addition to this layer is a small book icon 
that you see after the word “Polygons.”  This book icon 
will lead you to a list of references and a report about the 
“Vegetation Types in Coastal Louisiana in 2007.”  
This USGS publication can also be found online at 
pubs.usgs.gov/of/2008/1224/ 
 
 
 

 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
  

http://pubs.usgs.gov/of/2008/1224/
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The final item under Vegetation is an Assessment Tool. When you click on the word 
Assessment in blue, the Tools Menu allows you to select either Coastwide Vegetation or 
the Land/Water layer to assess.   
 
 
 
 
 

 
 
 
 
 
 
When you click on Coastwide Vegetation Layer and choose Hydro Basins as the 
Bounding polygon layer, Pontchartrain (PO) as the Bounding polygon, and 2001 
as the Year to assess, the map will change to the Pontchartrain Basin and the 
information window displays the vegetation type and acreage for that basin in 
2001.   Compare the changes over time by selecting different years. 
  
 

 

 

The Vegetation assessment tool can be used to visualize the vegetation types both 
in acres and percentages.  Select CWPPRA project as the bounding polygon 
layer.  BA-20 is project selected as the bounding polygon and 1978 as the year to 
assess.
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Soils 
 
To view the many 
different soils in 
Louisiana’s 
coastal zone, click 
the gray check 
box to the right of 
the Soils text to 
make that layer 
active and display the layer of data. 
 
There are hundreds of different soils in 
coastal Louisiana. Soil types are recorded in 
soil surveys. These soil surveys are then used 
by farmers, real estate agents, land use 
planners, engineers, and others who need 
information about soil resources.  
 
In coastal restoration, soils are important in 
understanding: how an area’s substrate will 
work for a restoration project, or as water 
purifiers, or in flood regulation. Soil surveys 
are also important in identifying which soils 
support which plants.  
 
The information about various soils can be 
accessed by clicking on the little book icon 
next to the word “Soil Type” which 
appears as a drop down list.   
This will link you to the USDA/NRCS  
website containing all the information about 
the SSURGO soils data. 
(soils.usda.gov/survey/geography/ssurgo/) 
 
 

Once the soil layer is active, the mouse will act as an interface for the soil type.  Move or roll the 
mouse over the area of your interest and left click the mouse.  The name of the soil will appear in 
an information box.  
 
For example, the soils in green 
in Lafourche Parish, identified 
by the arrow above are 
“Dowling soils” and are 
frequently flooded.  
 
 
 
 



 
   
 

Page | 29 
 

Public Lands 
 
The Public Lands layer identifies those lands that are in the public domain.  The legend at the bottom right indicates land owned by: 

• LDWF – the Louisiana Department of Wildlife and Fisheries (State of Louisiana property), 
• USFWS Acquired – the U.S. Fish and Wildlife Service (federal land that is acquired), 
• USFWS Inholding - the U.S. Fish and Wildlife Service (federal land that is inholding), and 
• NPS – the National Park Service (federal lands) 

 
By left clicking on the colored polygons with the public lands layer active the name of the location will appear.  
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Land/Water 
 
The Land/Water layer provides historical information about the 
changing Louisiana coast.  The light brown represents the land and the 
blue represents the water area. Click on the bar marked Land/Water 
and a drop down menu appears. Click on the year you would like to 
review and the map refreshes.  As a reminder, be sure the box to the 
left is checked. 
 
 

 
 
Additionally, this layer has an Assessment Tool that can be accessed by 
clicking on the term assessment at the bottom of the box. This tool 
allows you to visualize land/water through time as was described on 
page 16 and 21. 
 
 
 

The Land/Water assessment tool can be used to visualize the land to 
water ratios both in acres and percentages.  As an example, select 
CWPPRA Project as the bounding polygon layer.  BA-20 is the 
project selected as the bounding polygon and 1978 as the year to assess. 
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Base Layer 
 
The Base Layer allows the user to choose the background map that 
will appear.  Please note there are five general maps to choose from 
when creating a background map for the viewer.   
Note: You can only pick one layer at a time. 
 
The layers include: 

• World Imagery (ESRI created world imagery layer)  
Layers labeled as DOQQ stand for Digital Orthophoto 
Quarter Quad (digital aerial images produced by the USGS) 
and can be overlaid on top of the world imagery.  

     NC is natural color.  
     CIR is color infrared.  
 

• World Shaded Relief 
 
 
 
 
 
 
 

• World Street  
 

• World Topography 
 
 
 
 
 
 
 
 
 
 
 
 

• World Greyscale 
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CLASSIFY TOOL 

The Classify Tool is a useful tool to show a large scale picture of how 
CRMS sites are classified coastwide.  You can visualize all CRMS sites 
using the same classification so that sites can be compared against each 
other. Within the Tools Menu, Classify subheading, the user can 
select the type of classification to perform, define an attribute, and a 
year.  

 

For example, visualize all CRMS sites for a particular CRMS index such 
as the Floristic Quality Index (FQI). 

→ Activate the Tools Menu by clicking on the tools icon.  
→ For Type, choose Vegetation. 
→ For Attribute, choose FQI. 
→ For Year, choose 2012. 
→ Click on Classify. 

 

 

The map will change and all sites will be classified by the FQI based on 
field observations of species composition from 2012. 

 

This tool also helps if you are interested in investigating only a 
particular range of scores or values for a particular attribute.   For 
example, you could identify sites with high salinities (i.e. salt marsh) by 
selecting a small range and you can define how many intervals (or break 
points) are within the range. 

 

 

New attributes within this tool will become available as the program 
evolves.  
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VISUALIZATION 

The Visualization menu at the top of the CRMS website homepage 
has three tabs: Charting, Bulk Charting, and Conceptual Models.  These 
tools allow users to look at graphs and compare information over time 
or between projects and/or areas. 

 

Charting  

When you click on the Charting tab, data categories appear including: 
hydro, vegetation, soil, spatial, and report card. Clicking on any of the 
data categories will expand it to display available charts.  If you hover 
the mouse curser over any of the chart headings, an example thumb 
nail of what the chart looks like will be displayed to the right. The 
charting interface works the same way for each parameter. 

 

 

 

 

Follow the example below, to walk through the charting sequence.  

→ Click on Hydro. A dropdown menu will appear. 
→ Choose Water Level.  
→ Scale: Select a Scale will appear.  
→ Click the down arrow. 
→ Pick Site. 
→ Select the dates of your choice and click on Apply 

Date Filter.  
→ A box will appear with a list of sites that have data for 

the selected variable and date range. Choose 
CRMS0523-HO1 (Note: See Appendix 1 for more 
information on station naming conventions.) 

→ Click on Submit Request. 
→ The graph will appear at the bottom of the page. 
→ Single click on the graph to enlarge. 
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As graphs are generated, they will appear at the bottom of the page.  
The chart gallery enables the user to compare multiple charts for a 
CRMS site or charts for multiple CRMS sites simultaneously.    

 

BULK CHARTING  

From charting, clicking on the tab labeled “Bulk Charting” will load the 
bulk charting interface. Bulk charting allows the user to gather data on 
a variety of locations and have the data emailed directly to an active 
email address. The user can select multiple CRMS sites, set up graphs 
with consistent color ramps (ex. vegetation, site floristic quality index 
chart) and have large sets of charts generated and emailed. The user 
receives a “. zip” file with the user defined charts and the data used to 
generate the charts. 

Follow the example below, to walk through the bulk charting sequence.  

→ Choose Hydro. 
→ Choose Salinity. 

→ Select the dates of your choice and click Apply Date 
Filter. 

→ Choose the project(s) of your choice AT04-01 and 
AT04-03. 

→ Type your email in the white box at the bottom 
right. 

→ If you type in an incorrect email the message,  

      “Email is incorrect.” will pop up. 

→ Click on Submit Request.  

 

 Upon clicking Submit Request you should receive a message 
 that states, “Chart request has been sent to server. You will 
 receive an email when the charts have been created.” It usually 
 takes just minutes to receive the email. 
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The data will arrive in your email as “.zip” files.  The files can be downloaded to your computer. 

 

The information you receive may be both graphs and data on an Excel spreadsheet.  Once you have downloaded the files you may work with them on 
your own computer. 

    

 

 

 

 

 

 

 

 

 

Note: Depending on your email server you may want to download in batches to avoid overloading your email. 
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DATA DOWNLOAD 

Clicking the tab labeled “Data Download” will load the Data 
Download interface. The CRMS project allows users to download 
hydrologic, vegetation, and spatial data. It should be noted that the data 
available through this website are calculated or derived values based on 
the original data which are available from the SONRIS database 
(Sonris.com). 

 

 

To use this feature, click on the arrow for the parameter you wish to 
learn about.  

Use the example below to practice using this Data Download tool.  

→ Click Vegetation. 
→ Choose Veg Percent Cover. 
→ Scale: Select a coverage will appear. 

→ Click the down arrow and choose Species 
Percent Coverage. 

→ Pick 2012 by single clicking on 2012. It will move 
to the right selection box. 

→ Click Submit. 
→ Pick CRMS0523. 
→ Type in your email address. 
→ Click Submit Request. 

 

Again, the data will arrive in your email as a “. zip” file.  The file can be 
downloaded to your computer and used as described in the bulk 
charting section of this booklet. 

 

http://sonris.com/
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REPORTING 

The final section in the Visualization section of the CRMS website is Reporting. Reporting allows the user to Generate Report Cards for sites, 
projects, basins, or the entire Louisiana coast.  You can also view Operations, Maintenance, and Monitoring (OM&M) reports for individual CWPPRA 
coastal restoration projects.  

To Generate Report Cards simply click on the arrow and a list of Report Card types will be provided. Once a report card type is selected, Year will 
appear. Click the down arrow and choose the year. From the list that pops up choose the report you would like to view. Then click the Submit 
Request. The report cards are generated on-the-fly when the user makes selections so that the most up to date data is reported upon.  Once the report 
is generated a link will appear in the lower left corner.  Click on the link to open the document.  

To access OM&M reports for each of the CWPPRA coastal restoration 
projects first click the down arrow next to the words “State Number” and 
select a project number.  Remember, CWPPRA project names that 
correspond to the numbers can be found at 
LACoast.gov/new/Projects/List.aspx.   

 

 
 
 
 
 
 
 
 

 
 
 
 
 

http://lacoast.gov/new/Projects/List.aspx
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BRIEF SYNOPSIS 
 
There are several additional tools on the CRMS website and patrons are invited to continue to explore the additional resources the site has to offer that 
were not covered in this manual. The Library menu heading includes additional maps, presentations, Louisiana Department of Natural Resources 
(LDNR) reports, and CRMS reports.  Additionally, within the Visualization menu, users may find the Conceptual Models of delta building and 
wetland productivity useful.  Within the Program menu, there are also scientific reports about the Data Descriptions and Limitations available for 
all of the parameters monitored through the CRMS database. 
 
The CRMS program is as dynamic as the coastal habitats it monitors. The program continues to develop new products and assessment tools while 
providing data for model improvement and scientific research. The CRMS website is the current dissemination mechanism for all activities related to 
the CRMS program 
 
The value of the CRMS website approach is that it gathers information from a suite of sites that encompass a range of ecological conditions and is 
designed to be a one-stop shop for CRMS information, products, and data. The ecological data available through the Website are linked to the official 
Louisiana Coastal Protection and Restoration Authority (CPRA) database, which houses all CWPPRA monitoring data, on topics such as the following: 
hydrology, herbaceous marsh vegetation, forested swamp vegetation, soil properties, soil accretion, and surface elevation. Data provided by the 
Louisiana CPRA are also available for downloading at coastal.la.gov (Search: Monitoring Data). Data can be selected by project name, CRMS site, or 
station number.    

The CRMS network is currently funded through CWPPRA and the State of Louisiana. 
CRMS is providing data for a variety of user groups including: resource managers, academics, landowners, researchers, educators and students.

http://coastal.la.gov/
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SAMPLE PROBLEMS 

1.       The camp that my family owns just south of Point a la Hache (on the west bank of the Mississippi River south of New Orleans along Hwy 23) is 
surrounded by water now. My father told me there was marsh around it when he was my age.  How can I learn what it looked like before? How can I 
look up information to show me what happened?  Hint to find your answer: Consider using historical land/water trends and historical vegetation trends 

2.      I like to go fishing in Cameron Parish near the Cameron Prairie National Wildlife Refuge.  That area was closed for a while because it was hit hard 
by Hurricane Rita in 2005, and again by Hurricane Ike in 2008, and it looks really different now.  Is there something on the website that will show me 
how the marsh was affected?  Hint to find your answer:  Check on vegetation change or FQI.  Consider looking at the reports of the CWPPRA projects in 
the watershed, such as CS-17. 

3.      There is a CWPPRA project near the town that I live in, Cameron, and it is called East Mud Lake.  How do I find out how the project is 
doing?  Hint to find your answer:  Select the project CS-20 East Mud Lake Marsh Management. View all of the data and reports on the project.  Make your 
assessment.  

4.      I heard that there is an old CWPPRA project outside of New Orleans that you can see as you drive down Interstate 10 and that it is working really 
well.  All I see is a lot of grass.  How can I find out the details?  Hint to find the answer:  Select CWPPRA projects on the map. Then identify the project in 
the area you are looking for – Bayou LaBranche, PO-17 and read the documents. Share your details.  

5.      I read about diversions in the papers all the time.  How can I learn about them 
myself?  

6.  The land area in the southern part of St. Mary Parish near the Wax Lake Outlet is 
growing. I’d like to investigate the area.  Which part of the CRMS website should I 
use? Which tools tell me the most about the land change?  

7.      For my class in school, I have to write a report on Rockerfeller Wildlife 
Refuge.  Is there something on the website that will help me?  Are there CRMS sites in 
the Refuge? 



 
   
 

Page | 40 
 

Sample #1 Problem Solution  

1. The camp that my family owns just south of Point a la Hache (on the west bank of the Mississippi River south of New Orleans along Hwy 23)  is 
surrounded by water now. My father told me there was marsh around it when he was my age.  How can I learn what it looked like before and how can I 
look up information to show me what happened?  Hint to find your answer: Consider using historical land/water trends and historical vegetation trends. 

ANSWER:  You may choose to use the base layer as the “World Street” view to find Point a la Hache which is about 25 miles south of New 
Orleans along the Mississippi River.  
 
Click the CRMS sites on the map or activate the layers menu. Find Point a la Hache on the map. Use the + /- bar to zoom into the map. Use Port 
Sulphur as a reference point to find Pointe a la Hache. Port Sulphur is south of Pointe a la Hache adjacent to the Mississippi River. Port Sulphur can 
also be seen by zooming out a lot, thus making it a good reference point to find Pointe a la Hache. Return the map to “World Imagery” view for 
easier view of yellow CRMS dots.  Note the yellow dots indicate active CRMS sites.  
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
  
 CRMS sites are indicated with yellow dots and blue arrows in the map to 
 the left.   
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Notice there are three (3) CRMS sites on the map just southwest of the 
Mississippi River near Point a la Hache.  The sites are CRMS0258, 
CRMS3680 and CRMS0282 and are identified with blue arrows on the 
map on the previous page.  
 
To choose CRMS0258, click on the northern most dot or click CRMS 
in the layer menu and choose CRMS0258 from the drop down menu. 
The site information box will appear.  
 
 
 
 
 
 
 
 
 
 
  
  
 
Click on the Vegetation Tab\Marsh Classification subheading to 
see how the vegetation has been changing through time.  Notice how 
the marsh classification changed from brackish to saline between 2007 
and 2012 which indicates more saltwater in the area. 
  
 
 
 

Another tool to use is Charting.  Charting can be found under the 
word Visualization on the main CRMS home page menu.  Under 
Spatial select the percent land chart. Then you MUST select a site 
under the Scale drop down menu. Choose Site then CRMS0258 and 
submit the request. A Percent Land Graph will be created for that 
site. This graph shows a marked decline in percent land from 1985 to 
2010.  
 

  
One of the quickest things to do is to look at the Report Card Charts.  
Highlight the Site Index and Marsh Type Box Plot.  Choose HI for 
the Hydrologic Index, select CRMS0258, and click Submit Request.  
The graph below will appear.  Again, you can see that the marsh has 
changed from brackish to saline which indicates more saltwater in the 
area.  
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Another interesting thing to do is to compare the Land/Water spatial 
data over a longer period of time. Using the Land/Water layer click on 
the left check box to highlight the information  
 
1956 

 
 
2008 

 
 
A quick visual comparison will show the land lost in the area of the 
three identified CRMS sites.  

By clicking on Assessment and selecting the two years you would like 
to compare, you can get a graph to show you the changes in land and 
water. 
 
Or by clicking on Assessment and selecting CRMS sites for the 
bounding polygon layer, and CRMS0258 for the bounding polygon you 
can get an information box to describe land and water in a particular 
year.  Just click on the years of interest in the timeline within the 
information box. 

1956 

 
 
 

2008 

 
 
Notice that in 1956, 100% of the area was land but by 2008, only 35% 
is still land with the remaining 64% converted to water. 
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Another way to see the change visually is to use the Vegetation layer on the layers menu.  
 
Click on the check boxes, both the right and left of the Vegetation layer. Click on the bar next to the word Vegetation on the layers menu.  
 A drop down box will appear. For the Main Layer choose 1968 and for the Diff Layer choose 2007. Click to put a check mark in “Polygon 
 box.”  (Note: Checks may automatically be there for points, polygons, and legend. In that case, remove the Points checkmark.) Click the check 
 box to highlight the Legend.   
In 1968 the area was considered a brackish marsh; in 2007 it was considered a saline marsh.  This indicates more saltwater is in the area.  
 Don’t forget to hover over the Diff Layer on the map to see the year and vegetation type 
 

ANSWER to PROBLEM #1 
 
In many areas near the “camp” the land has been converted to water. As plants die and the 
landscape becomes open water, the soil in the area is exported out of the marsh by high tides and 
storm surges.  The water is also more saline than it has been in the past.  The plants have 
changed too. The plants have changed from tolerant of brackish to tolerant of saline waters. 
However, the change in salinity has been hard for the plant community to adapt to during 
this short time.  
 
 
 
 
 
 

 
 
Note:  The CWPPRA West Point a la Hache Outfall project is proposed for the 
area.  It is currently in the engineering and design phase.  Click on the check 
boxes to the right and left of CWPPRA layers menu to view the project and 
links to the associated fact sheet and comprehensive monitoring report.  
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Sample #2 Problem Solution  

2.      I like to go fishing in Cameron Parish near the Cameron Prairie National Wildlife Refuge.  That area was closed for a while because it was hit hard 
by Hurricane Rita in 2005, and again by Hurricane Ike in 2008, and it looks really different now.  Is there something on the website that will show me 
how the marsh was affected?  Hint to find your answer:  Check on vegetation change or FQI.  Consider looking at the reports of the CWPPRA projects in 
the watershed, such as CS-17. 

ANSWER: Start this problem by bringing up two layers on the map.  Be sure to click the box to the left of the CRMS bar and also the box to the 
left of the Public Lands.  You may also want to add the layer with the CWPPRA projects. This will add additional red lines to the image.  Now the 
CWPPRA project layer is active by checking the box to the right of CWPPRA. Choose CS-17 Cameron Creole Plugs from the CWPPRA Project 
drop down list. 
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The CS-17 Cameron Creole Plug project has several pieces of 
information that help you answer your question.  Under the 
Vegetation tab there is a subheading marked Side-by-Side.  
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
The Side-by-Side classification that pops up is 2007 and 2001. 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
From this quick look you can see that in 2007 the amount of brackish 
marsh in the project area has increased since 2001. 

You might also choose to go to the Tools and choose Coastwide 
Vegetation.  Click on the years 2001 and 2007 to get the data.  
 

This is a more quantitative 
way to look at the data.  
Notice in 2001, the project 
area had fresh, 
intermediate, brackish, and 
saline habitats with 
brackish marsh composing 
37% of the project. Also, 
water covered less than 1% 
of the area. 
 
 
 
 

 
 

 
 
 
In 2007, the project area 
was brackish and 
intermediate habitats with 
brackish marsh composing 
77% of the area. The good 
news is that in 2007 water 
did not increase from 2001. 
 
This lets us know that 
between 2001 and 2007 
land was not being lost. 

The area was changing vegetation and should be monitored and 
maintained to watch for additional land loss. 
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You may also choose to look at the Report Card for this project. The 
CRMS data on this project only goes back to 2006. 
 
Remember the Report Card includes both Floristic Quality (FQI) and 
Hydrologic (HI) Indices that have been created based on the suite of 
parameters available from the 2006 to 2009 CRMS data set. 
 
 
The FQI and the HI assessments were made relative to a baseline 
distribution of the index scores derived from 2006 to 2009 data at 
CRMS sites across the Louisiana coast. Because ideal thresholds were 
not available for the FQI and HI, scores were classified as 'good' 
(green) if they exceeded the 75th percentile of index scores calculated 
for all CRMS sites during the baseline period, 'poor' (red) if they did 
not exceed the 25th percentile, or 'fair' (yellow) if they were 
intermediate to the 25th and 75th percentiles. 

 
 
With that in mind, looking at 2006 we see the FQI in the low end of 
the fair range with improvements in the subsequent years.  The 
improvements are interesting but the type of marsh has certainly 
changed over time as indicated by the coastwide vegetation layer.   
 
The marsh is largely brackish habitat and the condition of the 
vegetation is improving as shown by the FQI. The projects in the area 
may be helping to reduce land loss rates.  
 
 
 
 

 
 
Viewers may choose to look at the CWPPRA fact sheet to learn more 
about what is being done.  
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Sample #3 Problem Solution  

3.      There is a CWPPRA project near the town that I live in, let’s say 
Cameron, and it is called East Mud Lake.  How do I find out how the 
project is doing?  Hint to find your answer:  Select the project CS-20 East 
Mud Lake Marsh Management and view all of the data and reports 
on the project. Make your assessment.  

ANSWER: If this is a project near your home, you will probably 
know where it is on the map.  In the event that you are not really sure, 
you may choose to use the base layer as the “World Street” view to find 
the area which is about 35 miles southwest of Lake Charles.  Click on 
the East Mud Lake Marsh Management Project. Return the map to 
“World Imagery” view. 
 

 
 
First click on the General Fact Sheet and read about the restoration 
project.  Record that the project was completed in 1997.   
 
 
 

The restoration strategy for the project was designed to stabilize salinity 
and water levels while ensuring the movement of commercial fish 
species into and out of the project area.  
 
Earthen plugs, flap gated culverts, variable crest culverts, and gated 
culverts were constructed and can be used to manage the flow of water 
into and out of the project area. In treatment unit 1, the structures have 
slots allowing ingress and egress of commercial fish species. 
 
 
 

The treatment unit structures have drawdown capabilities, encouraging 
shallow water areas to revert to emergent vegetation. The structures are 
closed when salinities exceed 15 parts per thousand (ppt). 
 
Smooth cordgrass (Spartina alterniflora) was planted to stabilize canal 
shorelines and encourage marsh regeneration. A reference area was 
chosen, and project area success will be determined by monitoring and 
comparing both before and after construction, land-to-water ratios, 
vegetation planting success, existing vegetation, soil bulk density, water 
quality, vertical accretion, surface elevation, and fisheries.
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The best way to evaluate this project would be to look at the 
information prior to 1997 and to look at the information in the most 
current time frame.  
 
 
After reviewing each of the tabs associated with CS-20 East Mud Lake 
Marsh Management you might choose to open the Report Card.  On 
page 6 of the Report Card, the FQI(floristic quality index) score 
appears. 
 

The FQI is moving from red to green between 2006 and 2012, which is 
positive.  
 
But this is not the only indicator of the project success or failure, other 
parameters should be examined. By continuing to look at the Report 
Card you will notice the HI score. The HI score appears to be static 
from 2011 and 2012 and in the poor category.  
 

 

 
Another quick indicator under the Report Card is the Project Scale 
Assessment: CS-20 Percent Land Change information. For this 
project information is show from 1985 to 2010.  
 
 

    
 
 
 
 
 
You may also want to investigate the project scale Submergence 
Vulnerability Index (SVI). 
 
Use your judgment to determine if the project is working to protect this 
area. 
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Sample #4 Problem Solution  

4.      I heard that there is an old CWPPRA project outside of New Orleans that you can see as you drive down Interstate 10 and that it is working really 
well.  All I see is a lot of grass.  How can I find out the details?  Hint to find the answer:  Select CWPPRA projects on the map. Then identify the project 
in the area you are looking for – Bayou LaBranche, PO-17 and read the documents. Share your details.  

ANSWER: Find New Orleans on the map. Use the + /- bar to zoom into the area. You may choose to use the base layer as the “World Street” 
view to find New Orleans between Lake Pontchartrain and the Mississippi River. Click on Layers Menu and choose CWPPRA. Click both the right 
and left check boxes to show the CWPPRA project area image and make the CWPPRA data available. You will notice two red polygons just west of 
New Orleans and north of Interstate 10.  The two polygons represent projects P0-17 Bayou LaBranche Wetland Creation and PO-75 LaBranche East 
Marsh Creation.  The smaller the ID number is the older the CWPPRA project. PO-17 was one of the first CWPPRA projects and was approved in 
1991. PO-75 was approved in 2010. Click on the polygon highlighting PO-17 to learn more about the “old” CWPPRA project that was actually part 
of the first Priority Project List (PPL).  You may choose to return the map to “World Imagery” view for easier viewing. 

 
Click on each of the tabs in the information box to learn more about 
the project.  
 
According to the fact sheet: 
 
Construction of Interstate 10 (with its associated construction access 
canals), the Illinois Central Railroad, and an abandoned agricultural 
development resulted in altered hydrology and increased salinity.  The 
primary cause of wetland loss in the area was the failure of agricultural 
impoundments and subsequent flooding. An unnamed hurricane in 
1915 and Hurricane Betsy (1965) caused salt water to overflow the 
banks of Lake Pontchartrain and flow unchecked through canals. This 
overflow resulted in excessive salt water in the project area marsh and 
a subsequent loss of intermediate marsh vegetation. The project's goal 
was to create an area of 70% land and 30% water within 5 years of 
construction. Depositing 2.7 million cubic yards of sediments dredged 
from Lake Pontchartrain within an earthen containment berm created 
new, emergent marsh in what had formerly been an open water area.  

 
Read through all of the tabs to make your evaluation of the project. 
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Sample #5 Problem Solution  

5.      I read about diversions in the papers all the time.  How can I learn about them myself?  

ANSWER: When you  go to the CRMS website homepage at LACoast.gov/crms2/home.aspx, 
you will notice the word Visualization appears at the top of the page. When you hover over the 
word a drop down menu appears.  Choose the words Conceptual Models and you will be brought 
to the page below.   
 
Click on Delta Building and a graphic 
representation of many of the elements 
that have an influence on delta building 
is displayed. Click on the Key tab to 
learn more about the model elements, 

the importance, current understanding, and predictability of these delta building 
elements and how they are related.  
 
Also when clicked, each one of the solid or dotted blue, green, and red lines provide 
information about how these delta building elements are connected.   
 
Additionally, under Citation there is a link to research reports related to the concept of 
using diversions to build wetlands.  
 
Reed, D.J. and W. Kim. 2008. Conceptual Model of Delta Building in Barataria Basin, Louisiana, 
Appendix 1, pp 59-76. In, Nuttle, W.K, F.H. Sklar, A.B. Owens, M. Inoue, D. Justic, W. Kim, E. 
Melancon, J. Pahl, D. Reed, K. Rose, M. Schexnayder, G. Steyer, J. Visser and R. Twilley. 2008. 
Conceptual Ecological Model for River Diversions into Barataria Basin, Louisiana, Chapter 7. In, 
R.R. Twilley (ed.), Coastal Louisiana Ecosystem Assessment & Restoration (CLEAR) Program: A 
tool to support coastal restoration. Volume IV. Final Report to Department of Natural Resources, 
Coastal Restoration Division, Baton Rouge, LA. Contract No. 2512-06-02. 
 
Additional links about diversions can also be found elsewhere on the web.  Some of these 
links include: LACoast.gov/new/Projects/Info.aspx?num=ba-33,  
sero.nmfs.noaa.gov/habitat_conservation/hcd_headlines/homenews_fwdiversions.html, 
wyes.org/local/coast/, or  
Also, consider going to the LaCoast.gov and researching the CWPPRA project Caernarvon Diversion Outfall Management, BS-03a. There is an 
Operations, Maintenance and Management (OM&M) report from 2011 and CRMS sites within the project boundary that can be used to learn more.

http://lacoast.gov/crms2/home.aspx
http://lacoast.gov/new/Projects/Info.aspx?num=ba-33
http://sero.nmfs.noaa.gov/habitat_conservation/hcd_headlines/homenews_fwdiversions.html
http://www.wyes.org/local/coast/
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Sample #6 Problem Solution  

6.    The land area in the southern part of St. Mary Parish near the Wax 
Lake outlet is growing. I’d like to investigate the area.  Which part of 
the CRMS site should I use? Which tools tell me the most about the 
land change?  

ANSWER: The Wax Lake Outlet is southwest of Patterson, LA 
south of US Hwy 90.   You may choose to use the “World Street” 
view to find the location. You will notice that there are several CRMS 
sites south of Patterson but the one CRMS site that is farthest south 
might provide the most interesting information. The site is 
CRMS0479. 

 
 
Change the map back to “World Imagery” and take a good look at the 
landform.  This dendritic (upside down tree) pattern is typical of 
distributaries off of a waterway. Click the right and left check boxes 
on the Hydro Basin layer and the most southern portion of the 
Atchafalaya Basin is highlighted in blue. This is the area of Louisiana 
that actually has some significant land gain.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Now click on the 
Land/Water layer and 
change the date to 1956. 
Notice that there is no land 
where the current CRMS 
site is located.  During 1956 
this landmass didn’t exist. 
 
Why do you think land was 
built after 1956? Read about the Morganza Spillway and Old River 
Control Structure for more information.  
 
Now, using the same 
Land/Water layer, click on 
2008.  The new map shows the  
land area being built at the 
outlet for Wax Lake. Additional 
land is also being built to the 
east off of the Atchafalaya 
River.  
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Another interesting item to view in the Atchafalaya Basin is the soil type.  This new sediment that is creating this land is being delivered through the 
Atchafalaya River system.  The newest sediment in this system is colored light green below.  
 
 
 
 
Another interesting comparison is the vegetation.  Click on the Vegetation 
layer and choose 1968 for the Main layer and None for the Diff(erence) 
layer.  You will notice that the colors are primarily dark green and blue 
indicating fresh marsh and waterways.  
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
Feel free to investigate other tabs under the CRMS0479 information box to learn about 
recent changes at the monitoring site.  
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Sample #7 Problem Solution  

 
7.    For my class in school, I have to write a 
report on Rockefeller Wildlife Refuge.  Is there 
something on the CRMS website that will help 
me?  Are there CRMS sites in the refuge? 
 
The CRMS website has some information 
about public lands. The Public Lands layer 
identifies those lands that are in the public 
domain.  The legend at the bottom right 
indicates land owned by: 

• LDWF – the Louisiana Department 
of Wildlife and Fisheries (State of 
Louisiana property), 

• USFWS Acquired – the U.S. Fish and 
Wildlife Service (federal land that is 
acquired), 

• USFWS Inholding - the U.S. Fish and 
Wildlife Service (federal land that is 
inholding), and 

• NPS – the National Park Service (federal lands) 
 
By right clicking on the colored polygon the name of the location will appear. The information provided includes the public land holder (example: 
LDWF), name of the land area, and the landholding acreage.   
 
You can gather information about Rockefeller Wildlife Refuge by looking at the information boxes for CRMS sites and CWPPRA projects within the 
refuge.  Also, the Land/Water and Vegetation layers will help you understand historic conditions with the refuge.  
 
Additional information can be found by contacting the managing agency of the property the Louisiana Department of Wildlife and Fisheries (LDWF) 
or wlf.louisiana.gov/about-rwr. 
.  
 
 

http://www.wlf.louisiana.gov/about-rwr
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Examples of Additional Coastal Restoration Questions to Address through CRMS:  
 

There are certainly additional questions that can be answered 
using the CRMS sites.  Try these on a project of your interest.  
 
1.   Did the restoration program reduce coastal wetland loss?  
 
 
2.   Did the restoration program sustain a diversity of 
vegetation types within the basins?  
 
 
3.   Is the restoration program effective in reducing major 
stressors on wetlands (i.e., flooding regime, salinity, elevation 
change)?  
 
 
4.   Which project types are the most effective in creating,        

                        restoring, protecting and enhancing wetlands?  
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Appendix 1: CRMS DATA COLLECTION INFORMATION AND SCHEDULE 

 

For the standard operating procedures: LACoast.gov/reports/project/CRMS%20SOP%202012.pdf 

Download data from SONRIS: coastal.louisiana.gov/index.cfm?md=pagebuilder&tmp=home&nid=129&pnid=76&pid=92&catid=0&elid=0. 

CRMS website: LACoast.gov/crms2/home.aspx.  

 

Hydrographic: Station number (H01): Continuous hourly salinity, temperature, and water level data at most sites the data logger is in an open water 
body or bayou.  

• Station number (W01): Continuous hourly salinity, temperature, and water level but the data logger is in a well in the marsh instead of an 
open water body. 

• Station number (M01): Marsh mat stations are established in floating marshes where the marsh mat rises and falls with water level. 
 

CRMS sites with real-time hydrologic gages: CRMS0061, 0282, 0411, 0465, 0568, 0609, 0615, 0651, 2418, 5373 -- 
waterdata.usgs.gov/la/nwis/current/?type=flow 

 

Soil Porewater: Station number (P01, P02, P03): Discrete collections of porewater salinity and temperature intermittently during the year while 
continuous hydrographic data are downloaded. Also collected at each vegetation station during herbaceous vegetation sampling in the late 
summer/early fall. 

 

Herbaceous Vegetation: Station number (V01, V02, etc.): Species composition, percent cover, and dominant height once annually (late summer/early 
fall) at 10 stations per CRMS site. 

http://lacoast.gov/reports/project/CRMS%20SOP%202012.pdf
http://coastal.louisiana.gov/index.cfm?md=pagebuilder&tmp=home&nid=129&pnid=76&pid=92&catid=0&elid=0
http://lacoast.gov/crms2/home.aspx
http://waterdata.usgs.gov/la/nwis/current/?type=flow
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Vertical Accretion (Station number [A01, A02, etc.]) and Surface Elevation (Station number E01): Collected by cryo-coring and rod-surface 
elevation tables, twice annually (spring and fall). 

 

Swamp Forest: Station name (F01): 

1) Forestry vegetation (every 3 years)- species composition and diameter at breast height (DBH) for woody shrubs and trees > 5 cm DBH (late 
summer/early fall). 

2) Canopy cover (every year)- canopy cover estimated with densiometers (late summer/early fall). 

3) Understory vegetation (every 3 years)- species composition, height, DBH, stem density of woody shrubs and trees < 5 cm DBH (late 
summer/early fall). 

4) Herbaceous vegetation (annually in the late summer/early fall)- same as for herbaceous vegetation as described above. 

 

Soil Properties:  Station number (S01, S02, etc): 

Soil properties are collected upon site establishment and every 10 years in marshes and 6 years in swamps. 

• pH, salinity, bulk density, soil moisture, percent organic matter, wet/dry volume 
 

Imagery: 

Coastwide satellite imagery is collected every year using Landsat Thematic Mapper (TM) multi-spectral imagery. 

Aerial photography is collected every 3 to 5 years. 
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NOTES:    
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WWW.LACOAST.GOV 

http://www.lacoast.gov/

